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Instructions for installing and configuring DNS
Server on Windows Server 2016

DNS configuration is similar to installing it, which means you don't need to be too bothered or ask any
administrator to help you do that, because you can do this yourself, with The following instructions are detailed
inthisarticle.

After installing DNS, of course, you need to configure DNS because it is an important task to help DNS work
correctly. DNS stands for Domain Naming System and the goal of DNS is to convert the name to an IP address
and IP address into a name, when you open a server or awebsite. For example, when you enter a site name like
www.quantrimang.com, here the DNS server will convert this name to an IP address and you can access the
website or access server resources. Today's article will show you the whole way to configure DNS Server on
Windows Server.

| nstall and configure DNS Server on Windows Server 2016

1. Install DNS Server on Windows Server 2016

2. Configure DNS Server on Windows Server 2016
1. Create a secondary zone
2. Learn about Reverse Lookup Zone

| nstall DNS Server on Windows Server 2016

The fastest way is to install the DNS server role on Windows Server 2016 using the following PowerShell
command (run it with admin rights):

Instal | - WndowsFeature DNS -1 ncl udeManagenent Tool s

You can also install the role DNS server from the Server Manager GUI . Open Server Manager and click
Add Rolesand Features.
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Choose Role-based installation or Feature-based installation options and click Next.

i Add Roles and Features Wizard - [m]
Select installation type ST cormne

Select the installation type. You can install roles and features on a running physical computer or vit
machine, or on an offline virtual hard disk (VHD)

® Role-based or feature-based installation
Configure a single server by adding roles, role services, and features.

_ Remote Desktop Services installation
Install required role services for Virtual Desktop Infrastrecture (VOI) to create a virtual machine-
or session-based desktop deployment.

Here you need to select the server to which you want to install DNS Server (usually the current server).

fzs Add Roles and Features Wizard o [m]
Select destination server ataninhy

Select a server or a virtual hard disk on which to install roles and features.

®) Selact a server from the server pool

Installation Type
.

Server Roles Server Pool

Filter:

Name IP Address Operating System

HOST1.contoso.com 192.168.1035 Microsoft Windows Server 2016 Datacenter

From the Server Roleslist , select DNS server and click Next. Click Add Features on the popup window - in
this case, the DNS management console and Power Shell DNS module will be installed automatically. If you

want to manage this DNS server remotely, you cannot install these tools.
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Select server roles HOST!.contonc

Select one or more roles to install on the selected server.

Roles Description
[ Add Roles and Features Wizard

Active Directory Cer|
Active Directory Do
Active Directory Fed|  Add features that are required for DNS Server?
Active Directory Ligh
Active Directary Righ  The foliowing tools are required to manage this feature, but do nc
Device Health Attest  have to be installed on the same server.

DHCP Server
4 Remote Server Administration Tools
Fax Server 4 Role Administration Tools

I (M| File and Storage Sen [Tools] DNS Server Tools

Host Guardian Servi
+ Hyper-V (Installed)
MultiPoint Services
Netwark Controller
Netwark Policy and
Print and Document]
Remote Access
Remote Desktop Se
Volume Activation §

Web S IS,
il ai [ Include management tools (if applicable)

[=

Now you can see that the DNS entry is selected.

T Add Roles and Features Wizard =

DESTINAY
Select server roles HosTH.
Before You Begin Select one or more roles to install on the selected server.
Installation Type Roles Description

Server Sslaction ” Domain Name System (D

[[] Active Directory Certificate Services | y A
m [] Active Directory Domain Services provides name resolution

[C] Active Directory Federation Services metworks. DNS Server iz o

Redies [C) Active Directory Lightweight Directory Services manage when it is I!nstall[e
DINS Server [] Active Directory Rights Management Services same server as Active Dirs
- [[] Device Health Attestation Domam _Serwces. If you st
onirmaten [C] DHCP Server Active Directory Domain !
role, you can install and ¢

[] Fax Server DNS Server and Active Di

I [W] File and Storage Services (1 of 12 installed) Domain Services to work

[ Host Guardian Service

¥ Hyper-V (Installed)

[ MultiPoint Services

[ Metwork Contraller

] Metwork Policy and Access Services

[] Print and Document Services

] Remote Access

[ Remote Desktop Services

] Volume Activation Services

[ Web Server (IIS) v

There are no additional features required for this step, but we want to make sure that the DNS Server Tools are
selected. To check this, click Remote Server Administration > Role Administration Tools. Then click Next.
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Select features HOSTH.conmoss

Before You Begin Select one or more features to install on the selected sarver.

Installation Type Features Description
Server Selection L Quality Windows AUCIO VIJEo tXpenence ~ Role Administration Tools inclug
Server Roles [] RAS Connection Manager Administration Kit (CM2 snap-ins and command-line toc

[] Remote Assistance for remotely managing roles.
[] Remote Differential Compression
4 (W] Remote Server Administration Tools (2 of 42 instal
Feature Administration Tools

DMS Server

v O
Confirmation PR lRole Administration Tools |
v ] AD DS and AD LD Tools
(i Hyper-V Management Tecls (Installed)
b [] Remote Desktop Services Tools
I
I

[[1 Windows Server Update Services Tools
[] Active Directory Certificate Services Tools
] Active Directory Rights Management Servic
] DHCP Server Tools
DNS Server Tools
] Fax Server Tools

1 [] File Services Tools
[ Metwork Controller Management Tools
] Metwork Policy and Access Services Tools

< >

< Previous. Next > Install . Can

Herejust click Next.

[ Add Roles and Features Wizard - ]
DESTINATION SE
DNS Server HOSTH contosc

Domain Name System (DNS) provides a standard methed for asseciating names with numeric Inte
addresses. This makes it possible for users to refer to network computers by using easy-to-remem
Installation Type names instead of a long series of numbers. In addition, DNS provides a hierarchical namespace,

ensuring that each host name will be unique across a local or wide-area network. Windows DNS s¢
can be integrated with Dynamic Host Configuration Protocol (DHCP) services on Windows, elimina

Before You Begin

Server Selection

Server Roles the need to add DNS records as computers are added to the network.
Features
Things to note:
* DNS server integration with Active Directory Domain Servi ically replicates DNS data

Confirmation

alang with other Directory Service data, making it 2asier to manage DNS.

* Active Directory Domain Services requires a DNS server to be installed on the network. If you an
installing a domain controller, you can also install the DNS Server role using Active Directory Do
Services Installation Wizard by selecting the Active Directory Domain Services role.

To confirm the installation, click Install.
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P e R e e DESTINATION SERVER
Confirm installation selections HOST1.conso.com

To install the following roles, role services, or features on selected server, click Install

| features (such as administration tools)
1 selected automatically. H you do not v
their check boxes.

ght be duplayed on this page because they have
it to install these optional features, click Previous to clear

DINS Server

) Ad A T
Confirmat Remote Server Administration Tools

Role Administration Tocls

DINS Server Tools

| < Previous | Mext > Install Cancel

The installation process starts and may take several minutes to compl ete.

When the DNS Server installation is completed successfully, click Close.

Fe Add Roles and Features Wizard — ] %
i rr R e o e DESTINATION SERVER
| .C\\ﬂl::_-}i on pi 1.-\-[-)- £55 HOSTY comeia zom

View installation progress

0 Feature installation

tallabion succeeded o

DNS Server
Remaote Server Administration Tools
Role Administration Tools

o seeriee®
WBUITS

You can close this wizand without interrupting running tasks. View task progress or open this
- i
B2 page again by clicking Notifications in the command bar, and then Task Details.

Export configuration settings

Close

Configure DNS Server on Windows Server 2016

DNS configuration is similar to installing it, which means you don't need to be too bothered or ask any
administrator to help you do that, because you can do this yourself, with The following instructions are detailed
inthisarticle.

1. When the DNS server is instaled, open the Server Manager window , click the Tools tab in the drop-down
menu that appears and click the DNS icon to open it. Here, the server's name in the example is set to the tactig-
dcO1.



» (&) | I" Manage | Tools &= View  Help

Active Directory Administrative Center
Active Directory Domains and Trusts
Active Directory Module for Windows Powershell
Active Directory Sites and Services

Active Directory Users and Computers

ADSI Edit

Component Services

Computer Management

Defragment and Optimize Drives

DHCP

Disk Cleanup

DMS

Event Viewer

Group Policy Management

iSCS1 Initiator Hide
Local Security Policy

Microsoft Azure Services

ODELC Data Sources (32-bit)

ODBC Data Sources (64-bit)

Performance Monitor

Print Management

Resource Monitor

2. First, what we need to do is create a zone. It is part of the DNS that logs are restored. To do this, right-click
the DNS server name on your computer and click New zone.

|!’I- DNS Manager

File Action View Help
e 2@ XDz HEm E &

£ DNS Name
» [ Forwa Configure a DNS Server...
? '7 Revers Create Default Application Directory Partiticns...
» ] TrustF
» [ Condit ; .
ﬂl Global Set Aging/Scavenging for All Zones...

Scavenge Stale Resource Records
Update Server Data Files

Clear Cache

Launch nslockup

All Tasks >
View »

Delete
Refresh
Export List...

Properties

Help



3. Skip the welcome page and on the next page, you will see three types of areas available.

1. Primary zone: The areais rewritten, not copied from somewhere.
2. Secondary zone: A copy of another area. When you create a secondary zone, you should copy the records

from another source.
3. Stub zone: This area provides information about any server holding a particular area.

Mew Zone Wizard 4

P

Zone Type
The DNS server supports various types of zones and storage.

-

Select the type of zone you want to create:

(®) Primary zone
Creates a copy of a zone that can be updated directly on this server.

(") Secondary zone
Creates a copy of a zone that exists on another server. This option helps balance
the processing load of primary servers and provides fault tolerance.

() 5tub zone

Creates a copy of a zone containing only Name Server (N5}, Start of Authority
(504), and possibly glue Host (A) records, A server containing a stub zone is not
authoritative for that zone.

Store the zone in Active Directory (available only if DNS server is a writeable domain
controller)

< Back Cancel

For example, if we want to create a primary zone, we will click on the primary zone, then click Next.

4. In the next page, you will be asked about the copy method.

1. First option, To all DNS serversrunning on domain controllersin the domain:, is used when you want
to copy with the primary domain and subdomains in the entire domain. Note that this will increase

network traffic.
2. The second option, To all DNS serversrunning on domain controllersin the domain:, is used when

you want the DNS server to copy all DNS serversin your own domain.
3. Third option, To all domain controllersin the domain this (for Windows 2000 compatibility): is used

when you want your server to only copy domain controllersin your own domain.

Please select the second option and then click Next.



Mew Zone Wizard

Active Directory Zone Replication Scope
You can select how you want DNS data replicated throughout your network,

Select how you want zone dats replicated:

() To all DNS servers running on domain controllers in this forest: tactig.com

(®)iTo all DNS servers running on domain controllers in this domain: tactig.com:

() To all domain controllers in this domain (for Windows 2000 compatibility): tactig.com

To all domain controllers spedfied in the scope of this directory partition:

5. On the Forward or Reverse Lookup Zone page, select Forward lookup zone . Forward lookup zone will
translate DNS name to IP address and the second option, Reverse lookup zone , will trandate IP into DNS
name. Just select Forward lookup zone and click Next. Rever se lookup zone will be configured later.

Mew Zone Wizard

Forward or Reverse Lookup Zone
‘You can use a zone for forward or reverse lookups.

Select the type of lookup zone you want to create:

(@) Forward lookup zone

& forward lookup zone translates DNS names into IP addresses and provides
information about available network services.

(") Reverse lookup zone

A reverse lookup zone translates IP addresses into DNS names.

6. Specify a name for the area, then click the Next button .



Mew Zone Wizard

Zone Name
What is the name of the new zone? '

The zone name spedifies the portion of the DMS namespace for which this server is
authoritative. It might be your organization's domain name (for example, microsoft.com)
or a portion of the domain name (for example, newzone.microsoft.com). The zone name is
not the name of the DMS server.

Zone name:
| Ectigzone|

< Back Cancel

7. How do you want the content in your area to update? The recommended option only allows security updates.
This option will help you not be affected by DNS servers and spyware (spyware). Please select the first option
and click Next.

Mew Zone Wizard

Dynamic Update
You can spedfy that this DMS zone accepts secure, nonsecure, or no dynamic
updates.

Dynamic updates enable DMS dient computers to register and dynamically update their
resource records with a DNS server whenever changes occur.

Select the type of dynamic updates you want to allow:

(®) Allow only secure dynamic updates (recommended for Active Directory)
This option is available only for Active Directory-integrated zones.

() allow both nonsecure and secure dynamic updates
Dynamic updates of resource records are accepted from any dient.
& This option is a significant security vulnerability because updates can be
L8 gccepted from untrusted sources.

() Do not allow dynamic updates
Dynamic updates of resource records are not accepted by this zone, You must update
these records manually.

< Back Cancel

8. After continuing, your primary zone will be created, just click the Finish button to begin working.



MNew Zone Wizard x

Completing the New Zone Wizard

specified the following settings:

' You have successfully completed the New Zone Wizard. You
=

Mame: tactigzone
Type: Active Directory-Integrated Primary

Lookup type: Forward

Mote: You should now add records to the zone or ensure
that records are updated dynamically. You can then verify
name resolution using nslookup,

To cloze this wizard and create the new zone, didk Finish.,

Now the area has been successfully created, but the DNS configuration has not been fully completed and the
secondary zone mentioned earlier is a copy of another area. That means you should copy the content from
another source. Now, the article will show you how to create a secondary zone.

Create a secondary zone

Y ou need another server, where the DNS server isinstalled on it. For example, naming the new DNS server is
tactig-dns02. The new server that you try to use as the second DNS server must be a member of Active
Directory Directory Services.

1. Now, we will work on the tactig-dns02 server , open the DNS Manager tool and right-click on Forward
lookup zone, click on the New zone and skip the welcome page by clicking Next. In the Zone Type page ,
select Secondary zone.



Mew Zone Wizard

Zone Type
The DMS server supports various types of zones and storage. '

Select the type of zone you want to create:

() Frimary zone
Creates a copy of a zone that can be updated directly on this server.

(®) Secondary zone
Creates a copy of a zone that exists on another server, This option helps balance
the processing load of primary servers and provides fault tolerance.

() 5tub zone
Creates a copy of a zone containing only Name Server (NS), Start of Authority
(504), and possibly glue Host (A) records. A server containing & stub zone is not
autharitative for that zone.

Store the zone in Active Directory (available anly if DNS server is a writeable domain
controller)

<Back Cancel

2. On the Forward or Reverse Lookup Zone page, select the option Forward lookup zone. It will change the
DNS name to the IP address. Then click the Next button .

Mew Zone Wizard

Forward or Reverse Lookup Zone
‘You can use a zone for forward or reverse lookups.

Select the type of lookup zone you want to create:

(@) Forward lookup zone

& forward lookup zone translates DNS names into IP addresses and provides
information about available network services.

{_)Reverse lookup zone
& reverse lookup zone translates IP addresses into DMNS names.

3. Specify a name for the area. Enter the name of the area you created previously as the primary zone. Here you
will have a copy of the primary zone in the secondary zone.



Mew Zone Wizard

Zone Name
What is the name of the new zone?

The zone name spedifies the portion of the DMS namespace for which this server is
authoritative. It might be your organization's domain name (for example, microsoft.com)
or a portion of the domain name (for example, newzone.microsoft.com). The zone name is
not the name of the DMS server.

Zone name:
| Ecﬁgzone|

< Back Cancel

4. In the Master DNS Servers page, you need to specify the master server Master server. The master server isthe
server you want to copy the content to the new secondary zone. Enter the IP address of the Master server and the

IP will be resolved. If the IP is correct, a green checkmark will appear next to the IP address box, then click the
Next button .

Mew Zone Wizard

Master DNS Servers
The secondary zone is copied from one or more DNS servers,

Spedify the DNS servers from which you want to copy the zone. Servers are
contacted in the order shown,

Master Servers:

IP Address Server FQDN Validated Delete
u o add an [P Add ar D g
@ 192.168.10.1  TactigDCo1 oK i
Down

5. When the Secondary zone is created, ssmply click the Finish button and finish.



Mew Zone Wizard

Completing the New Zone Wizard

‘You have successfully completed the New Zone Wizard, You
specified the following settings:

Mame: tactigzone
Type:  Secondary
Lookup type: Forward

File name: tactigzone.dns

Mote: You should now add records to the zone or ensure
that records are updated dynamically. You can then verify
name resolution using nslookup.

To dose this wizard and create the new zone, dick Finish.,

6. Now, click on the new area you just created, you will see ared x sign (meaning no content is present) and it
will not work exactly as it was mentioned before you Copy content from one place to another.

& DNS Manager

File Action View Help

o nmXECHm i ES

£ DNs -
v [ TACTIG-DCO2 G Zone Not Loaded by DNS Server

w | Ferward Lockup Zomes

gy tacti
- g-v Sehgons 7, The DNS server encountered a problem while attempting to load the zone. The transfer of
L - erse Lookup Zones zone data from the master server failed.
| Trust Points
» | Conditional Forwarders Cormect the problem then either press F3, or on the Action menu, click Refresh.
> Lim Global Logs . . .
For more inf about troubleshooting DNS zone problems, see Help.

7. Go back to the tactig-dns01 server , expand the Forward lookup zone mode and right-click the area where
you want to retrieve the copy, then select Properties.



& DNS Manager = o 3%
File Action View Help
s nFXEBezEBm §EE

& DNs Name Type Data Timesta
ke a T:QCFTIG-D:’OI n(:ame as parent folder) Start of Authority (SOA) [6] tactig-dcll tactig.co..  static
i (.:rwa Lool&u? Zones I—I (same as parent folder) Mame Server (NS) tactig-dc0l tactig.com. static
¥ & msdestactig.com
4 = iact! Al Update Server Data File
> | Reverse Looku Reload
» ] Conditional Fc Mew Host (& or AAAA)..
> L] Global Legs New Alias (CNAME)...
Mew Mail Exchanger (MX)...
New Domain...
New Delegation...
Other New Records...
DNSSEC >
All Tasks >
View >
Delete
Refresh
Export List...
>

Exports the current list to ¢

8. Here, select the Name Server s tab and add the server where you installed the secondary zone. When you add
the namein the list, you can copy the content. To do this, click the Add button .



tactigzone Properties

WINS Zone Transfers Security
General Start of Authority (S0A) | Mame Servers |

To add name servers to the list, click Add.

Mame servers:

Server Fully Qualified Domain Mame (FQDOM) IP Address
tactig-dc tactig.com. Unknown

Edit ... Remove

*represents an |P address retrieved as the result of a DMNS queny and may
not represent actual records stored on this server.

QK Cancel Apply Help

9. Enter the fully qualified domain name (FQDN) in the box as shown and the server's | P address below it. When
you resolve the server, a message will appear. Don't worry because the message will tell you that your server is
not authorized for that area. However, because you only want to make a copy of that area, click the OK button .



Mew Mame Server Record

Enter a server name and one or more IP addresses. Both are required to identify the name server.

Server fully qualified domain name (FQDMN):

tactig-dco2 | | Resalve
IP Addresses of this NS record:
TP Address validated Delete
<Click here to add an IP Address>
192.168.10.2 The server with this IP address is not ... Ho
Daown

| Cancel
10. Now go back to the tactig-dns02 server, right- click the areayou created and select Transfer from Master.

.:L DNS Manager

= o w
File Action View Help
e 2@ XEc|EBm i ED
£ DNS .
=] 4
v W TACTIG-DC02 'f@'l Zone Not Loaded by DNS Server
5 (L) Global Logs -
B F rd Lookup Z
i .olwa — The DNS server encountered a problem while attempting to load the zone. The transfer of
e 355 foren i o e Pl
» [2] Reverse Looky Reload
4 A Imsz.p?lmf E Transfer from Master or on the Action menu, click Refresh.
> = it 1
Transfer new copy of zone from Master ting DNS zone problems, see Help.
All Tasks »
View »
Delete
Refresh
Properties
Help

Deletes the current selection.

11. Refresh the page by clicking on the Refresh button and you will see all the records you can see in server zone
tactig-dnsO1. Now the secondary zone has been created and configured properly.



& DNSManager — O *

File Action View Help

T E PR EINEE
-1 D_NS MName Type Data Timestal
v B _TAcgiIGl;[::ch ﬂ{same as parent folder) Start of Authority (S0A) [9], tactig-decl.tactig.co... static
) ‘MIF i doLgs fup Z [F1isame as parent folder) Mame Server (N5) tactig-deol. static
w rean n
i _f t:dig::\eup i [Flisame as parent folder) Mame Server (N5) tactig-dc01.tactig.com. static
| Reverse Lockup Zones
v || Trust Points
. Conditional Forwarders
< >

L earn about Reverse Lookup Zone

The next important point in configuring DNS is that you should learn what Reverse Lookup Zone is. Reverse
Reverse Lookup Zone with Forward Lookup Zone means that it changes the IP address to a DNS name, ie when
you provide an IP address, it will give you a DNS name. To do this, you only need one DNS server and for
example will use the original DNS server (tactig-dns01).

1. Reverse Lookup Zone is created as the primary and secondary zones to expand server names. Right-click the
Forward Lookup Zone and select New Zone. When the new page appears, skip the welcome page and select
Primary zone and click Next. Keep the default options in the next step and click Next. Here, select 1Pv4
Reverse Lookup Zone or | Pv6 reverse lookup zone and click Next. For example, | will use the IPv4 version
but you can choose the area you want to use as you like.



Mew Zone Wizard

Reverse Lookup Zone Name
A reverse lookup zone franslates IP addresses into DMNS names,

Choose whether you want to create a reverse lookup zone for IPv4 addresses or IPvé
addresses,

(®) IPv4 Reverse Lookup Zone

() IPv6 Reverse Lookup Zone

2. At thistime, Network ID (network ID) is essential. Please specify Network ID and then click Next (Network
ID isyour network |P address).

Mew Zone Wizard

Reverse Lookup Zone Name
& reverse lookup zone translates IP addresses into DMNS names.

0

To identify the reverse lookup zone, type the network ID or the name of the zone.
(@) Network ID:
|192 168 .10

The network ID is the portion of the IP addresses that belongs to this zone, Enter the
network ID in its normal (not reversed) order.

If you use a zero in the network ID, it will appear in the zone name. For example,
network ID 10 would create zone 10.in-addr.arpa, and network ID 10.0 would create
zone 0.10.in-addr.arpa.

(_JReverse lockup zone name:
10. 168. 192.in-addr.arpa

3. Select the Allow only secure dynamic update option and click the Next button , then complete the next steps
to complete the configuration.



MNew Zone Wizard

ﬁ.

Completing the New Zone Wizard

You have successfully completed the Mew Zone Wizard. You
spedcified the following settings:

Mame:  10.168.192.in-addr.arpa

Type: Active Directory-Integrated Primary

Lookup type: Reverse

Mote: You should now add records to the zone or ensure
that records are updated dynamically. You can then verify
name resolution using nslookup.

To dose this wizard and create the new zone, dick Finish.

4. Run PowerShell with admin rights. Type the following command and press Enter :

i pconfig /registerdns

2 Administrator: Windows PowerShell

en initiated.

5. Refresh Forward Reverse Zone, you will see that an |P address has been added. All work is complete!

& DNS Manager = O x

File Action View Help

o= nmBbc=HBml 8@

& l)_NS Mame Type Data Timestamp

v @l TJ_\C:'IG-DCdO: _— [ ltsame as parent folder) Start of Authority (SOA)  [2], tactig-dc0ltactig.co...  static

o o-ward 0‘: U:_' i l—](same as parent folder) Name Senver (M5) tactig-dell.tactig.com. static

t“::.;:'o: gcom | 102,188,101 Pointer (PTR) Tactig-DCO1tactig.com.  5/1/2016 11:00:00 PM
] tactig.

tactigzone

~ [ Reverse Lookup Zones
) 10.168.192.in-addr.arpa
onditional Fonvarders

» (L] Global Logs




DNS configuration is complete. But thisis the basic configuration of DNS, and the advanced configuration steps
for DNS will be much more complicated, repeat it several times until you get used to the operation. If there are
any other questions, please leave a comment in the comment section below.

Good luck!
See more:

1. Instructions for installing Active Directory on Windows Server 2008
2. How to change DNS server on Chromebook
3. How to install the Print Server in Windows Server 2012

Y ou finished reading the article "I nstructions for installing and configuring DNS Server on Windows Ser ver
2016" edited by the TipsM ake team. We hope this article has provided you with many useful tech tips and
tricks. You can search for similar articles on tips and guides. Thank you for reading and for following us

regularly.
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